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Race-Keeper System Overview

Race-Keeper hardware combines the power of professional-grade video and data systems in one easy-to-use video
data package. Coupled with Race-Keeper Comparo analysis software, the Race-Keeper system is the most
powerful, competitively priced driver development tool available to help racers analyze and improve their driving.

Trivinci Systems is one of the world’s most capable and trusted providers of video data loggers. We have been
delivering video data systems to premier racing and driving experiences, racing series and programs for the past
five years across North America and Europe.
Race-Keeper Hardware
There are two Race-Keeper video data systems:

e Race-Keeper SE

e Race-Keeper HE

Race-Keeper SE (Green) and Race-Keeper HE (Black)

e Each Race-Keeper system is one box for video and data, delivering synchronized video and data, instantly and
automatically.

e Each system accommodates up to four cameras.

e Each system includes two video encoders which can capture two full-res video streams.

e Each system delivers stereo audio with built-in auto gain control.

e Each system captures data from multiple sources, including GPS, internal 3 axis accelerometer, OBD-Il and
CAN, and analog and digital sensors.

e Each system is WiFi ready.

The primary difference between the two systems is that Race-Keeper HE is waterproof.
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Race-Keeper Software

There are three types of Race-Keeper software:
e Race-Keeper system software installed on the Race-Keeper system
¢ Race-Keeper Comparo application software for video data analysis and driver development
e Optional plug-ins (e.g., ECU data sources, dual stream + HD export, etc.)
¢ Race-Keeper iDash software, an in-car data display with lap times, RPM, MPH, gear, and shift points

Race-Keeper Comparo delivers automatic alert updates for system software and Comparo software to registered
users.

Race-Keeper System Software

Race-Keeper system software controls system operation, system configuration, power management, auto-stop
and auto-start management, video resolution and LED functions. Race-Keeper system software is available at no
charge to registered users.

Race-Keeper Comparo

Race-Keeper Comparo driver development software is our analysis pack which plays synchronized video along with
synchronized course map and data traces, including speed, lap number, lap time, Gs and course map. Each of four
video data windows can be expanded for more detailed data and analysis. One of Race-Keeper Comparo’s most
powerful features is its drag-and-drop comparison of two outings on the same track, side-by-side.

RACE-
KEEPER

camePara

Race-Keeper Comparo also is available at no charge to registered users. Release updates are available at
www.race-keeper.com/support.

Race-Keeper Dual Stream + HD Export

Race-Keeper Dual Stream + HD Export is an optional plug-in to Race-Keeper Comparo which
Dusl

enables your Race-Keeper on-board system to capture two full-stream videos simultaneously, Srranh
Video

and expands Race-Keeper Comparo's export feature to export dual stream video, gauge
overlays and optional user-defined custom graphics to a 1920x1080 HD palette for playback
on an HD display.

+

HD Export
18Ro«1080

Please refer to the Race-Keeper Dual Stream + HD Export User guide for system configuration and instructions:
www.race-keeper.com/dualstream+HDexport.

Race-Keeper iDash

Race-Keeper iDash is an in-car data display which shows live race data including lap times,
RPM, MPH, gear and shift points. Race-Keeper’s iDash displays RPM, gear selection, speed,
current lap, last lap, and best lap times transmitted via WiFi from Race-Keeper’s on-board
video data systems to the dash display. Race-Keeper iDash stores start and finish line
positions for road courses, autocross, rally and hill climbs to provide accurate lap and stage
information.

Please refer to the Race-Keeper iDash User Guide for installation and operating
instructions: www.race-keeper.com/i-Dash.
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Race-Keeper ECU Data Modules

Race-Keeper Bosch ECU Data Module is a software add-on and an accompanying ECU
interface cable that enable Race-Keeper on-board system to capture data from Bosch ECUs.
There are two types of Bosch ECU Data Modules: Standard and Expanded. Standard acquires

Speed, RPM, Throttle, Steering angle, and Gear. Expanded acquires Water temp, Oil temp,
Intake air temp, Fuel pressure, Oil pressure, Exhaust temp, Brake pressure (rear), Brake

pressure (front) and Vehicle yaw rate.

Please refer to the Race-Keeper Bosch ECU Data Module User Guide for installation and operating
instructions: www.race-keeper.com/bosch ecu data module.
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Race-Keeper SE Schematic

e A-SD card slot

e B—Memory LED indicators for inserted media

e C-Video data recording pause button

e D - Video data recording manual start/stop button (optional auto-start/stop available)
e E—Power button

e F—Status LED indicators

e G —Video out port

e H—PC port (for development purposes only)

e | —USB port for OBD-Il or USB stick

¢ J—GPS antenna connector

e K — Microphone connector (dual mic input capable)
e L—Remote/Operator control connector

e M -1 to 4 camera connectors

e N —Analog and digital sensor connectors

e O - CAN connector

e P —Power and USB connector
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Race-Keeper HE Schematic

e A-SD card slot

e B—Memory LED indicators for inserted media

e C-Video data recording manual start/stop button (optional auto-start/stop available)
e D —Power button

e E—Status LED indicators

e F—GPS antenna connector

e G — Remote/Operator control connector (includes a USB port)
e H—USB connector for OBD-II, iDash

e | — PC port (for development purposes only)

e J—Video out port

e K — Microphone connector (dual mic input capable)

e L—1to 4 camera connectors

e M — Analog and digital sensors connector

e N — CAN connector

e O —Power/CAN connector

© Trivinci Systems, LLC Race-Keeper System User Guide v1.1.02, January 2011 Page 10 of 63



[RAEE-H
KEEFPER

Installing Race-Keeper

Race-Keeper Connectors

Race-Keeper uses rugged, locking Hirose connectors for all connectors, with exception of the GPS antenna, which
uses a threaded connector.

Race-Keeper peripheral connectors are pattern-keyed to ensure that peripherals attach only to the intended
connector on the Race-Keeper system.

To attach a connector, position the connector with the white arrow on top, push connector on to Race-Keeper
video data system; the connector has been successfully attached and locked when the connector “clicks” into
place.

To detach a connector, pull back on the black ring with the white arrow to release the connector lock.
->DO NOT twist the connector body!
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Installation Steps

¢ Install Race-Keeper video data system

e Use system mounting tray or Velcro to secure the Race-keeper system in your vehicle.

e Connectors should face front of vehicle for correct inline and lateral accelerometer orientation.
e Install camera(s)

e Ensure arrow is on top of camera(s).

e Square camera: Use alcohol wipe to clean mounting surface (e.g., windshield, dash); secure bracket to
mounting surface with double-sided tape.

e Bullet camera: use supplied bracket to secure to vehicle.
e Install microphone and GPS antenna
e Install mic in an area sheltered from wind noise.

e Install GPS antenna on roof (optimal), trunk lid or hood of the vehicle. GPS is used for speed data, lap time,
and course mapping; if the GPS antenna does not have a clear view of the sky (i.e., mounted inside the
vehicle), lap times and speed data may not be as accurate.

e GPS antenna has a magnetic base that will secure to a steel roof, trunk or hood. If the mounting surface is
not metallic, use 3M Dual Lock Velcro to secure the antenna.

o Install OBD-Il interface (optional) or CAN/ECU interface (optional) or analog/digital sensor(s) (optional)
e Connect OBD-II cable to vehicle OBD-II port and to OBD-Il module.
e Connect the USB cable from the USB type B connector on the OBD-Il module to the Race-Keeper system USB
input.
¢ Connect cables
e Attach connectors to Race-Keeper video data system.
e Connectors lock when attached (to disconnect, pull on black ring to release the connector lock).

¢ Route and hide/tie cables with plastic adhesive mounting pads and Ty-wraps; cables should be routed away
from severe heat sources or areas where they could be pinched or chafed.

e Connect power
e Connect power to cig lighter or direct to battery or master switch for more consistent power.
e Non-switched power is best to avoid video data outings being cut short if power is accidentally turned off.

For instructional video, please visit: www.race-keeper.com/video boxpower.
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Zero-ing the Accelerometer

After system installation, zero the accelerometer on the Race-Keeper system:
e Copy zero accel file ("trivinci.id") to a blank SD card or USB stick.

o File is available at www.race-keeper.com/accel zero

¢ Park vehicle on level ground.

e Power on your Race-Keeper system and wait until the system is ready.
e Insert SD or USB with the zero accel file into the Race-Keeper system.
e Transfer LED will start to flash.

e Remove the SD or USB after 10 seconds.

e Delete trivinci.id file from SD or USB before attempting to record a video data session to that media.

Calibrating the Accelerometer Orientation

After system installation, in addition to zero-ing the accelerometer on the Race-Keeper system, we recommend
calibrating the accelerometer orientation for correct display of inline and lateral Gs on the accelerometer gauge in
Race-Keeper Comparo. Please see How to Calibrate the Accelerometer Gauge for more information on calibrating
the accelerometer using Race-Keeper Comparo software.
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Race-Keeper LEDs

Before using the Race-Keeper system, please review the status and memory LED indicators below.

There are three different LED states

e On
e Flashing
o Off

The Status, Power and top Memory LEDs are dual color; different colors indicate different modes.

Status LEDs

finishing boot up process

LED Color On Flashing Off
Status ) | Green=Ready to record Red/Green=System starting | Not ready to record
OR
Green with Red every 2
seconds =No GPS
Transfer D Updating system, Accelerometer calibration Update complete
configuration updating, or stick/SD inserted
license file copying
Power ) | Red=Power connected, Red=Powering Power
system OFF Green=Low power disconnected
Green=Power on
Recording - Recording Stopping recording or Not recording

Memory LEDs

LED Color On Flashing Off
Memory 13 Yellow=Memory used >80% | Red=At 100% or no SD/USB <80% memory used
(Top)

Memory D Memory used=>25%, >50% NA No SD/USB or
(Bottom 3) and >75% memory used <25%

For instructional video, please visit: http://www.race-keeper.com/video LEDs.

© Trivinci Systems, LLC

Race-Keeper System User Guide v1.1.02, January 2011

Page 14 of 63




IRAEE-I_'
KEEFPER

Configuring Your Race-Keeper System

You can configure your Race-Keeper system to automatically power on and off, and to automatically start and stop
recording on speed and time triggers. You can also change your video quality settings and camera layout.

Configuring your Race-Keeper system is a two-step process:
e Select your configuration and copy configuration update file to SD (or USB for Race-Keeper SE).
e Copy configuration update file on the SD or USB to the Race-Keeper system.
Select Configuration and Copy Update File to SD or USB
e Open Race-Keeper Comparo and select Configure->Configure Race-Keeper.
7.4 Configure Race-Keeper.

Auto-power on and auto-power off Video quality and camera layouts

Automatically power on Race-Keeper | ) .
v system when power is connected, Video Quality

Iv¥ Automatically power off after Medium (13 min/GB) -

i5 minutes of inactivity (=4)

Mumber of cameras

i *2 3 {4
Auto-start and auto-stop recordings

€ s (* Dual st
[v Automatically START recording when Single Stream ¢+ Dual Stream

USEB key or SD card is inserted. Camera layout

Iv¥ Automatically START recording
...when speed reaches |5 MPH 0

[~ Automatically STOP recording

...when speed reaches |5 MPH
.. for |80 seconds.

Auto-start and auto-stop speeds limited to SxEEERlE

>2MPH to minimize unwanted sessions. Bosch MS3.1 -
Save | Defaults | Cancel |

e Enter required configuration and click on Save.

e Insert a blank SD or USB, select the SD or USB, and click OK to save the update file to SD or USB.

Select a Drive

Please select an external drive to use for
Race-Keeper Update:

5D Card or USE Drive

Copy Configuration Update File to Race-Keeper System

e Power on your Race-Keeper system and wait until the system is ready.

Insert SD or USB into the Race-Keeper system.

Transfer LED will illuminate solid for several seconds.

e When Transfer LED turns off, configuration is complete.

Delete configuration update file from SD or USB before attempting to record a video data session to that
media.
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Recording Video Data Sessions

e Power on Race-Keeper system
e System can be configured to boot automatically when power is connected

e See Race-Keeper Comparo->Configure menu; see Configuring Race-Keeper for more info

e Ensure SD media is inserted (or USB attached on Race-Keeper SE)
e System can be configured to record automatically upon insertion of SD or USB
e See Race-Keeper Comparo->Configure menu
e Push record button to start recording
e System can be configured to auto-record when the vehicle exceeds a configurable speed
e See Race-Keeper Comparo->Configure menu
e Push record button to stop recording
e Wait until Recording LED stops flashing before removing SD or USB

e System can be configured to auto-stop when the vehicle slows below a configurable speed for more than N
seconds, where N = number of seconds, defined by the user

e See Race-Keeper Comparo->Configure menu

Session Folder Names and Files
Race-Keeper automatically creates a folder for each recorded session. Race-Keeper automatically names the folder
according to the following convention:
o Hit##t YYYYMMDD_HHMMSS, where
o i#t# = Race-Keeper system serial number
e Race-Keeper SEs begin with 1 or 2 and Race-Keeper HEs begin with 5 or 6
e YYYYMMDD = Date of session
e HHMMSS = Time of session (GMT)
Note: There are three files inside a session folder:
e outing.rkd, which encapsulates data and synchronization files,
¢ video.avi, the container for the video files, and
¢ video.avi.rki, a proprietary index file

Note: If you use Import (see Importing and Opening Track Outings), Race-Keeper Comparo will append the above
nomenclature to a folder that is created using the Name field from the Import menu.

Race-Keeper produces video and data files independently, which gives maximum flexibility to configuring gauge
overlays and exported video files.

When finished recording sessions, ensure the recording has stopped and the red Record LED is off, remove media
and insert SD or USB into PC and use Race-Keeper Comparo to play, analyze and compare sessions.
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Updating Your Race-Keeper System Software

We deliver Race-Keeper systems with current system software at the time of shipment. We issue updates to Race-
Keeper system software to add new features, enhance existing features, and fix bugs.

We notify customers regarding updates to system software via Race-Keeper Comparo, which automatically issues
alert updates to registered users.

When an update is available for Race-Keeper system software, you will receive a system update alert:

| A Race-Keeper systern update is available. We recornmend that you
' update your Race-Keeper system. Would you like to update your

Race-Keeper system now? You will need a USE stick or an 5D card.

To update Race-Keeper system software:

Click Yes.

Copy the software update to SD.

Power on your Race-Keeper system and wait until the system is ready.

DO NOT REMOVE OR INTERRUPT POWER DURING THE SYSTEM SOFTWARE UPDATE PROCESS.
Insert SD into the Race-Keeper system.

Transfer LED will illuminate solid for up to several minutes.

System should automatically reboot and continue the update sequence.

System update may require the system to update and restart twice.

o If system has been unresponsive for five minutes, reboot your Race-Keeper system manually and permit the
system to continue updating.

When system has booted up and is ready, your system has been properly updated.

Delete system update file(s) from SD or USB before attempting to record a video data session to that media.

In addition to automatic alerts in Race-Keeper Comparo, you can manually determine if you’re using the latest
system software

Open Race-Keeper Comparo.
Select Help->Check for Comparo Software Updates.

& RaceKeeper Comparo

File Compare Configure View
About Race-Keeper Comparo |

Go to Race-Keeper Comparo Video Tutorials (Internet)
Check for Comparo PC Software Updates

Check for Race-Keeper System Updates

Keyboard Shortcuts

For instructional video, please visit: www.race-keeper.com/comparo_screencasts?which=04 updatehw.
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Race-Keeper Cameras

There are two types of Race-Keeper cameras:

Mini-bullet Mini-square

¢ Mini-bullet delivers highest resolution (550 TV lines) camera in a waterproof enclosure; perfect for open-
wheel, open-cockpit, external (e.g., root-top) video capture, and motorcycles. Includes standard L-bracket.
¢ Mini-square delivers highest resolution (550 TV lines) camera in a lightweight package. Excellent camera for
inside most vehicles, including road and auto-cross cars. Includes mounting bracket and double-sided 3M VHB
mounting tape for quick and secure installation.
All cameras are terminated with 10-foot cables; 10-foot extension cables are available. All cameras are tested and
focused prior to shipment. Cameras do not require focusing unless the lens is replaced or otherwise disturbed.

For instructional video, please visit: www.race-keeper.com/video cameras

Collar Clamps

For more secure installations, roll hoop collar clamps are available for mini-bullet cameras in the following sizes: 1
3/8”,1%",15/8",1%",and 17/8".

Lens Options
Mini-square camera is available with four lens options: 6.0mm, 4.3mm, 3.6mm, and 2.5mm
Mini-bullet camera is available with three lens options: 6.0mm, 3.6mm, and 2.95mm.

Each lens type is offered to capture the best angle - from narrow to wide - for required video capture. Lens size
affects distance and field of view — a smaller lens value will show a shorter viewing distance and a wider field of
view; a larger lens value will allow for a longer viewing distance but a narrower field of view. For example, a 2.5mm
lens produces a wider angle (155 deg approx) than a 6.0 mm lens (120 deg approx).

e Front — 6.0mm for speedway, 4.3mm (mini-square camera) for road race, or 3.6mm for auto-cross

Rear —3.6mm

Inside/Cockpit — 2.5mm lens (mini-square camera), 2.95 mm lens (mini-bullet camera)

Footwell — 2.5mm lens (mini-square cameras), 2.95 mm lens (mini-bullet camera)

Suspension, Brake and Tires — 2.5mm lens (mini-square camera), 2.95 mm lens (mini-bullet camera)
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Replacing Lens Cover on Mini-bullet Camera

The lens cover protects the bullet camera lens from damage due to stones, dust and moisture. If the bullet camera
is mounted on the outside of the vehicle, the lens cover should be wiped clean after every track session, and
replaced after each race weekend to ensure the camera image is always crisp and clear.

To replace the lens cover:
e Unscrew the front section of the bullet camera that holds the lens cover (lens cover holder).
e Remove the inner metal spacer ring, the black ‘O’ ring and the old lens cover from the lens cover holder.
e Clean the lens cover holder and the ‘O’ ring to remove road dirt.

¢ Holding by its edges, drop in the new lens cover being careful not to touch the lens cover surfaces, ensure the
lens cover is seated at the front of the lens cover holder.

e Drop in the black ‘O’ ring and ensure it is seated up against the new lens cover.

e Drop in the metal spacer, ensuring the shouldered end goes in first — this sits over the ‘O’ ring to hold it and
the lens cover in place.

e Screw the lens cover holder back onto the camera — tighten all the way so the ‘O’ ring on the camera body can
no longer be seen.

Once the new lens cover is in place, spray with repellant (e.g., Rain-X) to ensure water does not obscure the video
image when driving in wet conditions.
Replacing a Camera Lens

All cameras are tested and focused prior to shipment. Cameras do not require focusing unless the lens is replaced
or otherwise disturbed.

To replace a camera lens:
e Using a small screwdriver, untighten the lens set screw located on the side of the camera body.
e Using your index finger and thumb, unscrew the lens from the camera body.
e Carefully thread a new lens onto the camera body until the lens seats on the body.
¢ Do not force or overtighten the lens.

e Focus the lens (see instructions below) before tightening the set screw.

Focusing a Camera Lens with External Monitor
To focus a camera lens using an external monitor:
e Connect camera to one of the four camera inputs on the Race-Keeper box.
e Connect an external monitor (e.g., portable DVD player) to the video out port on the Race-Keeper system.

e Video out cables are also available at www.race-keeper.com.

e Turn on the Race-Keeper system.

e The video from the camera will be displayed on the external monitor.

e Make sure there is adequate lighting and an object in the field of view that can be used as a target.
e Loosen the lens set screw with a small flat blade screwdriver.

e Turn lens clockwise or counter-clockwise until the image is focused.

e When the camera lens is focused, tighten the set screw.

¢ If you have some Loctite, place a tiny drop on the screw threads to prevent the screw shaking loose due to
vehicle vibration.

e Do not put Loctite on the lens threads.
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Focusing a Camera Lens Without an External Monitor

If no video monitor is available, you can focus the camera by recording video and playing the video on a PC using
Race-Keeper Comparo (or any MPEG4 video player, e.g., VLC).

To focus a camera without using an external monitor:
e Connect camera to one of the four camera inputs on the Race-Keeper box.
e Make sure there is adequate lighting and an object in the field of view that can be used as a target.
e Make sure a microphone is attached to the Race-Keeper system.
e Turn on the Race-Keeper system and press the record button.
¢ Loosen the lens set screw with a small flat blade screwdriver.
e Turn the lens counter clockwise in % increments, counting as you go until you reach 10 % turns.
e Push the stop button, remove the USB stick or SD card and play the session using Race-Keeper Comparo.
e Watch the video and note at what % increment the video comes into focus; repeat process if necessary.

e Once you've identified the number on which the camera is focused, turn the lens clockwise, counting %
increments backward from 10 until you reach the desired number.

o Verify the focus by recording and playing a few minutes of video.

e If necessary, record another video sample and turn the lens 1/4 turn in both directions from the starting point
to refine the focus; repeat process if necessary.

e When the camera lens is focused, tighten the set screw.

¢ If you have some Loctite, place a tiny drop on the screw threads to prevent the screw shaking loose due to
vehicle vibration.

¢ Do not put Loctite on the lens threads.

Race-Keeper Microphone

Race-Keeper’s microphone is extremely durable and picks up an exceptional range of audio, including conversation
or radio when in the pits, and engine noise on the track. Race-Keeper system software includes built-in Automatic
Gain Control, which adjusts audio levels automatically to maintain a constant sound level.

To install the microphone, place it forward and away from direct wind noise if possible. If you're recording in an
open cockpit (e.g., in a single-seater race car or in a road car with windows down), consider adding a wind cover to
dampen irritating high-frequency wind interference.

For instructional video, please visit: www.race-keeper.com/video mics.
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Race-Keeper Data Sources

Race-Keeper offers dozens of data sources for all types of data requirements, covering the range of driver inputs
(brake, throttle, steering) and vehicle inputs (speed, RPM, temps, pressures).

There are four different major types of data sources, the traces of which are automatically displayed in Race-
Keeper Comparo:

¢ Standard data
e OBD-Il data
e ECU data
¢ Sensor data
All data sources are logged at 30Hz.
Data from all data sources is synced automatically and instantly with Race- Keeper video and other data sources.

Standard data is delivered with every Race-Keeper system; each additional data input delivers expanded data sets
for additional driver and vehicle analysis.

For instructional video, please visit: www.race-keeper.com/video data

Standard Data

Every Race-Keeper system delivers essential data for driver development:
e Speed
e Lap numbers

e Lap times

Split times

Lateral, vertical and inline Gs
e Voltage

Race-Keeper acquires speed from high-resolution GPS, which also enables lap number, lap times, split times, and
display of course map with user-configurable split markers. G data are acquired from on-board accelerometer
inside the Race-Keeper system enclosure; for optimal G data, install Race-Keeper system with connectors facing
front and after installation, zero the accelerometer.

OBD-Ill Data
To acquire additional data from road cars, Race-Keeper acquires data from OBD-II (On-board Diagnostic).
All cars and light trucks built since January 1, 1996 are equipped with OBD-II.
Depending on the make/model, OBD-Il data delivers up to 10 additional data channels:

e Vehicle speed

e Engine RPM

e Throttle position

e Engine coolant temperature

e Fuel pressure

e Intake air temperature

¢ Intake manifold pressure (manifold absolute pressure (MAP))

e Mass air flow (MAF)

e Fuel level input

e Calculated engine load value
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Configuring Your Race-Keeper System for OBD-II

There is NO configuration required; connecting the interface automatically stimulates the system to acquire OBD-II
data. Race-Keeper Comparo also automatically displays the additional OBD-Il data.

Connecting OBD-Il to Your Race-Keeper System

To connect the OBD-Il interface to your vehicle and your Race-Keeper system:
e Power off your Race-Keeper system.

e Connect the OBD-II connector to your vehicle.

OBD-Il port on vehicle

o Note: OBD-Il ports are typically located on the driver side above the pedals under the steering column.

OBD-II
connector

e Two types of OBD-Il connectors are available for Race-Keeper: right-angle and straight, which is displayed
above.

e Connect the other end of the OBD-Il connector to the Race-Keeper OBD-II Interface (serial connector).
e Connect the USB B connector to the other end of the Race-Keeper OBD-Il interface (USB B port).
e Connect the other end of the USB cable to the Race-Keeper system.

o If you use Race-Keeper SE, attach USB connector to the i) USB port on the enclosure, or ii) USB connector
that is part of the power loom, or iii) Remote/Operator control connector (with special cable, please contact
Race-Keeper).

o If you use Race-Keeper HE, attach USB connector to the i) USB connector with supplied cable, or ii)
Remote/Operator control connector (with special cable, please contact Race-Keeper).

Connect to USB
port on
Race-Keeper
(HE USB
connector
displayed)

Race-Keeper
OBD-II
Interface

Connect to OBD-II
port on vehicle

e If you’re using more than one USB device (e.g., OBD-Il and Race-Keeper iDash), we recommend connecting
devices to different USB connectors on your Race-Keeper system (i.e., and not using a USB hub).
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Acquiring OBD-II Data from Your Vehicle’s OBD-II
To acquire ODB-II data:

e Power on your vehicle (i.e., turn key to Ignition).
e Depending on OBD-Il interface model, red Status LED should turn on, indicating that the OBD-Il interface is

properly connected and powered by 12v from the vehicle.

e Power on your Race-Keeper system.

e The Status LED should turn green, which indicates that the OBD-Il interface is properly connected to the
Race-Keeper system.

e The Tx (transmit) and Rx (receive) LEDs will flash as OBD-II data is
transmitted from the vehicle to the Race-Keeper system (i.e., requests
each OBD-Il data channel from the vehicle’s ECU; the ECU responds with
data value).

OBD PC
o ¢ o0

Tx Rx Status Tx Rx

ECU Data

To acquire data from vehicles with race or aftermarket ECUs, Race-Keeper connects to CAN (Controller Area
Network) or serial data stream output from the ECU. Depending on the make/model, ECU data delivers many
additional data channels, including:

e Speed

e RPM

e Throttle

e Steering angle

e Gear

o Water temp

e QOil temp

e Intake air temp

e Fuel pressure

e Qil pressure

e Exhaust temp

e Brake pressure (rear)
e Brake pressure (front)
e Vehicle yaw rate

For more information on ECU data, including configuring your Race-Keeper system to acquire ECU data, please
refer to the ECU CAN data modules at www.race-keeper.com and/or each ECU CAN data module’s respective user
guide.
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Sensor Data

To acquire data from vehicles that do not have OBD-Il or ECUs, Race-Keeper acquires data from analog or digital
sensors.

o If you're using Race-Keeper SE, you can connect up to 8 analog and 8 digital sensors.

e If you're using Race-Keeper HE, you can connect up to 3 analog sensors and 2 digital sensors.

Analog Sensors

Race-Keeper works with 5V string potentiometers that are ideal for quickly measuring and analyzing the three
most important driver inputs:

e Steering (port 1 on Race-Keeper SE, top row, left RJ-45 socket)
e Throttle (port 2 on Race-Keeper SE, top row, second from left RJ-45 socket)

e Brake (port 3 on Race-Keeper SE, top row, third from left RJ-45 socket)

art sensors (connect to any port)

<can/obd-ii

Steering Throttle Brake

Race-Keeper is set up to work automatically with each of the three analog sensors. The sensors are water resistant
with a flexible cable, spring-loaded spool and potentiometer to detect and measure linear position. Sensors have a
temperature operating range of 0°F (-18°C) 160°F (71°C).

To install an analog sensor:
e Analog sensor is supplied terminated with the correct connector to fit either the Race-Keeper SE or HE; sensor
is plugged into the Race-Keeper system or sensor tails loom as appropriate.

e Sensor also is supplied with a mounting bracket; securely mount the sensor with this bracket so the sprung
wire is drawn directly out of the sensor by the moving part to be measured.

e Attach the sensor’s wire tip to the moving part by wrapping around twice and securing in place.

e Route the sensor cable away from sources of interference (e.g., ignition coils, plug leads, electronic modules or
antennas).

¢ Verify that the cable is not pinched or stretched by moving parts; verify that the moving part is not restricted
or affected by the sensor installation.

e Make a recording with the Race-Keeper system while activating the moving part(s) with sensors attached.
¢ Verify that the data channels appear in Race-Keeper Comparo under the correct channel names.

o If the data for a sensor appears to be inverted, right-click on the sensor channel name and select the option
to Invert Sensor Data
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Tach Input

Race-Keeper’s tach input cable connects a tach signal from your vehicle's ignition system to the digital tach input
on the Race-Keeper system. The tach data signal should be a clean square wave, nominally 0-5v. The tach cable
contains a protection circuit to ensure the Race-Keeper system isn’t damaged if the input signal from the ignition
system is too powerful or contains electrical noise.

e If you’re using Race-Keeper SE, connect the bare wire to tach signal on the vehicle and connect the RJ-45
connector into the bottom right port on the Race-Keeper system.

¢ If you're using Race-Keeper HE, connect the bare wire to tach signal on the vehicle and connect the sensor
input connector to the Sensor input loom.

Race-Keeper SE Tach Input Cable Race-Keeper HE Tach Input Cable

Race-Keeper Comparo manages calibration of the tach input signal. Once an outing has been recorded with the
tach cable connected, the tach data will appear as an available data channel in Race-Keeper Comparo, which you
can calibrate by right-clicking on the RPM channel name and selecting the number of pulses per two engine
revolutions. Once the number of pulses has been selected, verify the RPM readings on the data trace are correct. If
they are not, modify the pulse value until the correct RPM data range is seen.
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Data Sources Quick Reference

Data Source Race-Keeper Comparo
Speed (GPS) Standard Speed (GPS)

Lap number(s) Standard Lap #

Lap time(s) Standard Lap

Lateral G Standard Lateral G

Vertical G Standard Vertical G

Inline G Standard Inline G

Voltage Standard Voltage

Vehicle speed OBD-lI Speed (OBD-Il)

Engine RPM OBD-II RPM (OBD-I1)

Throttle position OBD-II Throttle (OBD-II)
Engine coolant temperature OBD-lI Coolant Temp (OBD-II)
Fuel pressure OBD-lI Fuel Pressure (OBD-Il)
Intake air temperature OBD-II Intake Air Temp (OBD-II)
MAP (Intake manifold absolute pressure) OBD-II MAP (OBD-II)

MAF (Mass air flow) OBD-II MAF (OBD-I1)

Fuel Level Input OBD-II Fuel Level (OBD-II)
Calculated engine load value OBD-II Engine Load Calc (OBD-II)
RPM (Digital Sensor or Tach) Sensor RPM (Tach)

Steering (Analog Sensor) Sensor Steering (Sensor)
Throttle (Analog Sensor) Sensor Throttle (Sensor)
Brake (Analog Sensor) Sensor Brake (Sensor)

Speed ECU Standard Speed (ECU)
RPM ECU Standard RPM (ECU)
Throttle ECU Standard Throttle (ECU)

Steering angle

ECU Standard

Steering Angle (ECU)

Gear ECU Standard Gear (ECU)
Water temp ECU Expanded Water Temp (ECU)
Oil temp ECU Expanded Oil Temp (ECU)

Intake air temp

ECU Expanded

Intake air Temp (ECU)

Fuel pressure

ECU Expanded

Fuel Pressure (ECU)

Oil pressure

ECU Expanded

Oil Pressure (ECU)

Exhaust temp

ECU Expanded

Exhaust Temp (ECU)

Brake pressure (Rear)

ECU Expanded

Brake Pressure-Rear (ECU)

Brake pressure (Front)

ECU Expanded

Brake Pressure-Front (ECU)

Vehicle yaw rate

ECU Expanded

Vehicle Yaw Rate (ECU)
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Race-Keeper Software

There are three types of Race-Keeper software:
e Race-Keeper system software installed on the Race-Keeper system
e Race-Keeper Comparo application software for video data analysis and driver development
e Optional plug-ins (e.g., dual stream + HD export, ECU data sources, etc.)
e Race-Keeper iDash software, an in-car data display with lap times, RPM, MPH, gear and shift points
This section addresses Race-Keeper Comparo.
See previous section(s) for information about Race-Keeper system software.

For information about Race-Keeper Dual Stream + HD Export, see www.race-keeper.com/dualstream+HDexport.

For information about Race-Keeper iDash, see www.race-keeper.com/i-Dash.

For information about Race-Keeper Bosch ECU Data Module, see www.race-keeper.com/bosch _ecu data _module.

Race-Keeper Comparo

Race-Keeper Comparo driver development software is our analysis pack which plays synchronized video and data.

RACE-
KEEPER

camFP3rg

Race-Keeper Comparo automatically plays video along with synchronized course map and data traces, including
speed, lap number, lap time, Gs and course map. Each of four video data windows can be expanded for more
detailed data and analysis. One of Race-Keeper Comparo’s most powerful features is its drag-and-drop comparison
of two outings on the same track, side-by-side.

Race-Keeper Comparo also is available at no charge to registered users. Release updates also are available at
www.race-keeper.com/support.

Installing Race-Keeper Comparo Software

Race-Keeper Comparo works in tandem with Race-Keeper on-board systems, which captures and automatically
and instantly synchronizes high-res video and data. With Race-Keeper Comparo software, you can quickly identify
how to improve your driving and decrease your lap times.

To install Race-Keeper Comparo:
¢ Download installation file

e www.race-keeper.com/support/downloads, or

o www.race-keeper.co.uk/support/downloads

e Copy the installer to your desktop and follow the setup instructions.
e Click Finish to automatically start Race-Keeper Comparo.

For instructional video, please visit: www.race-keeper.com/comparo_screencasts?which=02 install.
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Updating Race-Keeper Software

When you open Race-Keeper Comparo, you’ll notice an occasional alert message that indicates a software update
is available.
There are two types of Race-Keeper software updates:

e Race-Keeper system software updates (Updating Your Race-Keeper System Software for more info).

e Race-Keeper Comparo application updates (see below).

How to Update Race-Keeper Comparo Software

When an update is available for Race-Keeper Comparo software, you will receive the following alert:

To update Race-Keeper Comparo:
e Click Yes.
¢ Follow update instructions.
e Click Finish to automatically start Race-Keeper Comparo.

For instructional video, please visit: www.race-keeper.com/comparo_screencasts?which=05 updatesw.

© Trivinci Systems, LLC Race-Keeper System User Guide v1.1.02, January 2011 Page 28 of 63



RACE-
KEEFPER

Menus and Main View

Race-Keeper Comparo Menus

After you’ve opened a Race-Keeper Comparo outing, you’ll note that there are five menus:

For instructional video, please visit: www.race-keeper.com/comparo_screencasts?which=07 menus.

Configuring Race-Keeper

File, for opening, importing and exporting features

Compare, for comparing laps and outings

Help, for checking for software updates

Configure, for configuring Race-Keeper Comparo and Race-Keeper system software

View, for switching between standard and expanded views, and

Race-Keeper Comparo gives you the power to easily configure your Race-Keeper system for different auto-start,

auto-stop and video quality parameters. Configuring your Race-Keeper system is a two-step process:

Select Configure->Configure Race-Keeper

e Use Race-Keeper Comparo to select your configuration settings

A — Auto-power on and auto-power off

B — Auto-start and auto-stop

C - Video quality

D — Number of cameras

e Camera layout options change dynamically

E — Single stream or dual stream (optional)

e See Race-Keeper Dual Stream + HD Export for more info on dual stream mode

F — ECU data source (optional)

e See ECU Data for more information on ECU data source

Auto-power on and auto-power off

v Automatically power on Race-Keeper
system when power is connected.

¥ Automatically power off after
15 minutes of inactivity (=4)

Auto-start and auto-stop recordings

Automatically START recording when
USE key or 5D card is inserted.

I Automatically START recording
...when speed reaches | & MPH

W Automatically STOP recording

...when speed reaches |5 MPH

wfor | e0 seconds,

Auto-start and auto-stop speeds limited to
»2 MPH to minimize unwanted sessions,

Save | Defaults | Cancel

e Enter required configuration and click on Save.

Video guality and camera layouts
Video Quality

Standard (54 min/GB)

Number of cameras

"1 T2 O3 54
(¥ Single Stream " Dual Stream

Camera layout

1
2]3 4

~

Select ECL type

None =
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e Insert a blank SD or USB, select the SD or USB, and click OK to save the update file to SD or USB.

Select a Drive

Please select an external drive to use for
Race-eeper Update:

SD Card or USE Drive

Cancel

Copy Configuration Update File to Race-Keeper System

e Power on your Race-Keeper system and wait until the system is ready.

e Insert SD or USB into the Race-Keeper system.

e Transfer LED will illuminate solid for several seconds.

e When Transfer LED turns off, configuration is complete.

¢ Delete software update file from SD or USB before attempting to record a video data session to that media.
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Race-Keeper Comparo Shortcut Keys

Race-Keeper provides a number of helpful shortcut keys; shortcuts are identified by letters to the right of each

menu label.

How to View All Shortcut Keys

To view a complete list of shortcut keys:

e Select Help->Keyboard Shortcuts

Open outing Ctrl + F4
Compare outings SorFl
Compare laps RorF2
Uncompare AorF3
Maximize data graph P or F4
Maximize outing info DorFS
Maximize track map TorF6
Maximize video player B or F7
Restore windows Eor F&8
Volume up -

+tx<CcZz—oCc-O0

Close outing
Toggle MPH
Toggle RPM
Toggle inline G
Toggle lateral G
Toggle delta time
Toggle throttle
Toggle brake
Toggle steering
Volume down

Spacebar Play or pause both outings in Compare mode
Double-click Resync two outings (data and/or map)

> 1 Forward 1 second playing (1 frame if paused)
“« 1 Reverse 1 second playing (1 frame if paused)
Shift + = # Forward 1 second playing (1 frame if paused)
Shift + « # Reverse 1 second playing (1 frame if paused)

Page Down 1 Forward 1 lap
Page Up 1 Reverse 1 lap
Shift + Page Down 2 Forward 1 lap
Shift + Page Up # Reverse 1 lap
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Importing and Opening Track Outings

How to Import a Race-Keeper Track Session

To import a Race-Keeper session:

e Select File->Import.

e Insert SD or USB with the track sessions.
¢ You may receive an alert regarding verification of attached media, please allow Comparo to verify the media.

Verifying Media

Race-Keeper Comparo is verifying the inserted memory
device, This will take just a few more seconds. Flease wait.

¢ If more than one media is inserted, select the drive letter from which to import session(s).

e Click on session(s) to import (hold Ctrl to select multiple sessions).
¢ You can add name, type, driver and car info to individual sessions (you can also add/edit details later).

Importing from

Date & Time

9/12/2010 1:39 PM

] | — Ot
Importing to Session Name Driver
CAUsers\JBH\Desktop\Test Outings | | VIR Race 2 |R0hh Holland j New

Session Type Car
j New |2DDS\-"W GTI Z.D—Iiterj New

|Racez

Import | Done

[~ Delete sessions from 5D or USB after import

e Refer to or click on the “Importing to” button to review or change the destination location on your PC.

e Click Import.
e After an outing has been imported, it will appear in the list of outings in the Open window (see next section).

Search

Session |5tarttime | Laps | Best time
2010-09-12 13:38:27 2 02:58.44

5228_20100912_173827
VIR Race 2 2010-09-12 13:39:28 02:15.33

m

< | |
Scan v Show Preview Delete | Open |

For instructional video, please visit: www.race-keeper.com/comparo_screencasts?which=06 _import.
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How to Open a Race-Keeper Track Session

To open a Race-Keeper session:
e Use Import (see above) or copy file(s) from your SD or USB to a folder on your PC.

e If you copy your files from SD or USB directly to a folder on your PC (i.e., you don’t use Import), you will need
to point Race-Keeper Comparo to the folder(s) in which your session folders reside.

~

Mame Size Type Date modified
. 5228 20100912 173927 File Folder 9/30,2010 4:10 PM
5411 20100912 173928 File Folder 9/30,2010 4:10 PM

e Select File->Open and click on Scan to navigate to the folder with the track sessions.

Browse For Folder

| Seszions
5228 20100912 173927
5411 20100912 173928

Make Mew Folder

e Click OK and all sessions within the target folder are scanned and available in the list of sessions in the Open
window; new sessions are added to the bottom of the list.
e Click on a Race-Keeper session and then click Open.
->You can open and play session(s) directly from USB or SD but we strongly recommend copying sessions to your
PC for optimal playback.
For instructional video, please visit: www.race-keeper.com/comparo_screencasts?which=03 open.
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Four Main Areas of a Race-Keeper Session

There are four main areas of a Race-Keeper session:

Video player, which plays video synchronized with data

Data graph, which displays data traces synchronized with video

Course map, which shows the course

Session info, which shows lap info and splits

For instructional video, please visit: www.race-keeper.com/comparo_screencasts?which=08 4areas.

How to Navigate a Race-Keeper Session

To navigate a Race-Keeper session:

Click on the navigation bar on the video player, or

Click on any point on the data graph, or

Click on any point on the course map, or

Click on a lap in session info

Because video and data are synchronized instantly and automatically at time of capture, navigation on one of the
four windows automatically changes the location on the other three windows.

For instructional video, please visit: www.race-keeper.com/comparo_screencasts?which=10 navigation.

How to Expand and Shrink Race-Keeper Windows

Each of the four areas in a Race-Keeper Comparo session can be expanded to provide more information.
To expand a Race-Keeper area:

e Click on the Maximize button in the top right-hand corner of each of the four areas

Lap 4 01:32.95
Lap 5 01:31.79 |E:<par1|:| window gdﬁ-efn
C

ore detailed info

To restore a Race-Keeper area back to its original size:

e Click on the Restore button in the top right-hand corner of each of the four areas

For instructional video, please visit: www.race-keeper.com/comparo_screencasts?which=09 expand.
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More About the Video Player

Video Player is one of the four main areas of a Race-Keeper session.

Race-Keeper’s video player provides:

Video playback control

Lap number and lap time

GPS date and time stamp (date and time)

Inter-lap navigation controls
When you expand the video player, the intra-lap navigation control appears for more granular navigation within
the current lap, along with any splits that you’ve established.

& Race-Keeper Comparo 0.11.02.38
File Compare Cenfigure Yiew Help

=

Open

BICFlTraEkULlS'lUZ o [ ][

lap2 01:11.40 15/1/2010 7:06:50.81

e A —Play/pause (or use Spacebar)
e B —Inter-lap navigation
e C—Intra-lap navigation (example displayed with splits established by user)

For instructional video, please visit: www.race-keeper.com/comparo_screencasts?which=12 morevid.
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How to Add, Move and/or Remove Gauges

Race-Keeper Comparo displays animated gauge overlays that can be added or removed from the video player.

Race-Keeper produces video and data files independently, which gives maximum flexibility to configuring gauge
overlays and exported video files.

To add or remove a gauge to/from the video player:

e Select Configure->Gauge Manager

Speedometer

Accelerometer

Color N

Throttle

e Click on pull-down menus to select gauge

[~

|RK White Transparent Zj

[~

|White Transparent 10 j

[~

|Tran5parent j

The Race-Keeper system should
be positioned in the vehicle with
connectors pointed towards the
front; if connectors are not
pointed towards the front, grab
and drag the red line in the
direction to which connectors
are pointed.

On
Gradient Opagque -

e Gauge preview is displayed in thumbnail and on video player

e Click the On button to toggle the gauge(s) on and off

e Click on@ to close Gauge Manager

To move a gauge on the video player:

e Click mouse button on the gauge to grab the gauge, hold down the mouse button and move the gauge

For instructional video, please visit: www.race-keeper.com/comparo_screencasts?which=13 addgauge.
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Gauge Library

Race-Keeper Comparo is pre-loaded with a gauge library which includes transparent and opaque graphical gauges,
as well as several dozen popular production vehicle gauges.

Speedo Tach Accel Throttle
White Transparent 180 White Transparent 10 Transparent Black Opaque
White Transparent 140 White Transparent 8 Opaque White Opaque
Black Opaque 180 White Transparent 16 White Transparent
Black Opaque 140 White Transparent 20 Blue Transparent
Red Transparent 180 Black Opaque 10 Green Transparent
Red Transparent 140 Black Opaque 8 Red Transparent
Blue Transparent 180 Black Opaque 16 Yellow Transparent
Blue Transparent 140 Black Opaque 20
Green Transparent 180 Red Transparent 10
Green Transparent 140 Red Transparent 8

Yellow Transparent 180 Blue Transparent 10
Yellow Transparent 140 Blue Transparent 8

White Opaque 180 Green Transparent 10
White Opaque 140 Green Transparent 8
AMG E63-CLK63 Yellow Transparent 10
AMG SL63 Yellow Transparent 8
AMG SLK55 White Opaque 10
Audi R8 White Opaque 8
Audi RS4 AMG CLS63
BMW M Coupe AMG E63-CLK63
BMW M3 AMG SL63
BMW M5 AMG SLK55
Corvette 206 Audi R8
Dodge SRT Audi RS4
Ford Mustang BMW M Coupe
Jeep SRT BMW M3
Porsche Carrera BMW M5
Porsche 911 GT3RS Ford Mustang

Jeep SRT

Porsche Carrera
Porsche 911 GT3RS
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How to Calibrate the Accelerometer Gauge

After you’ve installed your Race-Keeper system, we recommend calibrating the accelerometer.

To calibrate the accelerometer gauge:
e Select Configure->Gauge Manager

Accelerometer

Color N

On
|'|=ra nsparent :J

Tha Race-Eaapar Fystem Ehauld
B pogitonsd in the vehicle with
connecton pointed towards the

front; if connectors are not
pointed towards the front, grab
and drag the red line in the
dirgeuan o which connecnars
Bre poainted.

e Move the red line on the accelerometer gauge thumbnail to the direction in which connectors on the Race-

Keeper system are pointing (i.e., if system is installed with connectors facing the front of the vehicle, point the

red line to the top (i.e., north)

¢ Play the loaded video data outing and verify that i) during braking, the colored dot on the vertical axis moves
up the scale and during acceleration, the colored dot moves down the scale, and ii) during left-hand turns, the
colored dot on the horizontal axis moves to the right, and vice-versa.

For instructional video, please visit: www.race-keeper.com/comparo_screencasts?which=14 accelcal.

How to Zero the Accelerometer on the Accel Gauge

After you've calibrated your Race-Keeper system, you can also zero your accelerometer gauge for each session.

To zero the accelerometer gauge:

e Navigate to a point in a session in which vehicle is stationary and on flat pavement (e.g., beginning or end of

session)
e Right-click on the accelerometer gauge
¢ Click Center

For instructional video, please visit: www.race-keeper.com/comparo_screencasts?which=15 accelzero.
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More About the Course Map

Course Map is one of the four main areas of a Race-Keeper session.
Race-Keeper’s course map provides:

e Bird’s eye graphical view of the course

Graphical indicator of vehicle position on course

Corresponding data for vehicle position on course

Video thumbnail and playback control

Full navigation controls

& RaceKeeper Comparo 0.11.02.38

File Compare Cenfigure View Help

= \

| Best Lap Current Lap

All Laps

B BICFL Track01-15-10 2

1

! . ! . ! ! B ! " !

S

Lap Lap time Max MPH
2 025470 1168

i
-

9
@& weH (GPS 1003 'S
O lateral 6 7
O inline G 011
" Vertical G 035
C Voltage 1376

(¥ Distance " Time

®

e A —Video thumbnail with player controls

e B — Data for exact position on course

C — Inter-lap navigation
D — Start/finish line

E — Vehicle position on course

F — Splits (added by user, see next section)
e G — Color-coded legend for different sets of data

e H— Weather vane for course rotation

For instructional video, please visit: www.race-keeper.com/comparo_screencasts?which=18 moremap.
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How to Move the Start Line on the Course Map

Race-Keeper Comparo assesses data for each track session and automatically assigns a start/finish line position on
the course map. Race-Keeper Comparo uses the start/finish line to establish lap number, lap times and splits
(configured by the user).

The start line is indicated by a blue arrow, which also displays the direction of travel of the vehicle on the course.

£

You may want to fine-tune or change the position of the start/finish line.
There are two ways to move and/or set the start line.
To move the start/finish line on the course map:
e Place mouse over the blue arrow to highlight the arrow
e Click to grab the arrow
e Move the arrow forwards or backwards on the course map
To set the start/finish line at the cursor position:

¢ Review video and/or data trace to identify exact position of start line — stop the video with your vehicle right
at the start line; use left and right arrow keys to move the video one frame at a time backwards or forwards.
e Select Configure->Put Start Line at Cursor Position

For courses in which the start and finish lines are different (e.g., autocross, rally, hill climb), set the session type to
Autocross in the Edit Outing details menu. You can set the finish line by selecting Configure->Put Finish Line at
Cursor Position.

For instructional video, please visit: www.race-keeper.com/comparo_screencasts?which=19 mapstartline.

How to Add and Move Splits to the Course Map

One method to assess how well you drive on different parts of the track is to split the course map into splits and
then evaluate your time and video for each split segment.

To add a split marker:
e Place your mouse over a spot on the course map
e Right click on the split marker
¢ Insert Split Markers Here
To move a split marker:
e Place your mouse over a split marker
e Click to grab the split marker
e Move the split marker forwards or backwards on the course map

To view split times and corresponding video and data, expand the Session Info window and select Show Splits; see
More About Session Info for more info.

For instructional video, please visit: www.race-keeper.com/comparo_screencasts?which=20 mapsplits
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How to Delete Splits From the Course Map

There are two ways to delete split markers: individually or all markers.
To delete an individual split marker:
e Expand the course map
e Place your mouse over a split marker
¢ Right click on the split marker
o Select Delete Splits Marker
To delete all split markers:
e Select Configure->Delete All Section Markers
e Select Yes to confirm
For instructional video, please visit: www.race-keeper.com/comparo_screencasts?which=21 mapdeletesplits

What the Colors Indicate on the Course Map

When the course map is expanded, there is a legend in the bottom-right corner, which indicates what the colors
represent on the course map.

To change the values of the legend:
e Minimize course map
e Place mouse over scale of vertical axis (e.g., speed) on data graph

¢ Raise or lower the tick markers on the scale to change the values of the legend

For instructional video, please visit: www.race-keeper.com/comparo_screencasts?which=22 mapscale
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More About the Data Graph
Data Graph is one of the four main areas of a Race-Keeper session.
Race-Keeper’s data graph provides:

e Color-coded data traces for acquired data

¢ Selection pane for turning data traces on/off

e Vertical and horizontal scales, with corresponding values

e Display based on distance or time

& RaceKeeper Comparo 0.11.02.38

File Compare Configure View Help

open | Compare | | \

-
9
9

.03

Lap Lap time Ma} MPH
1 063783
RPM (OBD-I1)

fAzEzﬂ 51439ft 68585ft

85731ft

102877t

120023ft

137169t

4530

@ 34292ft 51439ft 68585ft

85731ft

102877t

RPM (OBD-11)

2 2
Throttle (OBD-11) ¥R 857
COURSEMAR g h:r?tt_e:\_DBD— ) :se
60 Jwﬂmmwr EDDIEF‘\[";EmplEIED-HJ lDi‘D‘D
I Intake Air Temp (0BD-11) 30.00|=
. ‘" MAP [OBD-1) 276
10 I Fuel Level (0BD-I1) 0.51
m \[” Engine Load Calc (0BD-11) 0.98
@ @Lr Laterat & 018
I inline G 01009
I wvertical G -0.09
SeStraight, T=Turn ™ Voltage 1415 -
GD“::D:HTSE:\E:‘[:)::: 34292ft 51439ft 68585ft B85731ft 1028771t 120023ft 137169ft
e A —Video thumbnail with player controls
e B — Course map and vehicle position on course
e C—Data trace label and vertical axis
e D - Color-coded data traces
e E—Horizontal axis (displayed by either distance or time)
e F—Vehicle position
e G — Selection pane
For instructional video, please visit: www.race-keeper.com/comparo_screencasts?which=23 moredata
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How to Add or Edit Data Traces

Race-Keeper Comparo automatically displays a selection pane and all available data sources for each session.
To add or edit data traces:

e Review the available data traces in the selection pane

¥ MPH [GPS) 1001
["| MPH [OBLC 8097
[ RPM [OBD-II) 5,678
[ Throttle (OBD-11) 16.3
| | Coolant Temp [(OBD- 208°F
| ' Intake Air Temp (OBD-11) 95°F
| | MAP (OBD- 0.55
| Fuel Level (OBD-I1) 5.4
| | Engine Load Calc (OBD-11) 431
| Lateral G 0.04
| Inline G 0.24| »

¢ Click box next to data trace(s) to toggle traces on/off

Note: Colored data traces correspond to the primary outing; in Compare mode, data traces are gray for the
secondary outing.

In the expanded data graph, Race-Keeper Comparo automatically displays up to three data trace windows
corresponding to the selected data traces.

For instructional video, please visit: www.race-keeper.com/comparo_screencasts?which=24 dataexpand

How to Zoom to Examine Data More Closely

To view data more closely, Race-Keeper Comparo provides the capability to zoom.
To zoom data:

e Select View->Zoom Graph
Zoom data is available in either standard or expanded views.

For instructional video, please visit: www.race-keeper.com/comparo_screencasts?which=25 datazoom
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More About Session Info
Session Info is one of the four main areas of a Race-Keeper session.
Race-Keeper’s session info provides:

e Information about the session

e Listing of laps and corresponding lap times

e Splits report

& Race-Keeper Comparo 0.11.02.38
File Comparc Cenfigure View Help

open | showinfo | [ Showspits  Compare | |

6 SCCA Runcffs T2 [EE=]
- L | - | o | 5 | - | | - | - | - | | = | 3 | L &
9 b Ll 0 . T = i T B T T : T N T y 0 0 ‘ T y 0 ¢ T 8

Lap time S1 T2 53 T4 T3 T6 s7 T8 9 510 Ti1 512 T13 514 515 Ti6 517
Target 2:30.85 12.85 6.17 390 1078 7.41 3.77 527 948 1415
1 23412 1281 6.21 397 1081 777 380 531 961 1438
2 2:32.48 1201 4.00 10.88 7.57 537 961 14.25
3 23258 1291 6.21 4.00 1091 7.54 3.84 534 9.64
4 2:33.52 13.05 6.31 4.04 10.94 764 3.84 531 9.68 14.28
5 2:32.61 1295 6.24 404 1084 754 3.80 537 961 1421
6 23321 6.34 414 1108 754 3.80 531 961 1431
o 7 2:33.21 12901 8.24 1104 774 3.90 537 854 14.35
Lap Lap time Ma:xgvIPH g 1291 6.24 3.97 10.84 3.84 534 9.58 14.28
1 02:3412 13 9 2:33.95 13.01 627 404 7.47 384 531 961 1425
10 2:35.58 1291 631 397 1094 757 3.80 531 958 1435
1 23261 1285 627 3490 1088 754 387 1431

2:32.78
23425
4:57.13

toedispht markers

A —Video thumbnail with player controls

e B — Course map and vehicle position on course

e C - Listing of laps

e D — Splits (configured by user)

e E —Best split times across all laps, highlighted in green
e F—Target lap (summation of best splits across all laps)

To navigate to any section, click on the lap or any split within a lap.

For instructional video, please visit: www.race-keeper.com/comparo_screencasts?which=16_moresessioninfo
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How to Edit Session Info

Session info provides important info about each Race-Keeper session.
To edit session info:

e Select Configure->Edit Session #1 (or 2) info

Session Path I C:\Jsers\Desktop\Favorites

Session Mame I |

Session Type I

Driver

Course

|
Car I
|

e Select from pull-down menu(s) or
e Click New to add selection options
e Click OK when finished

For instructional video, please visit: www.race-keeper.com/comparo_screencasts?which=17 editsessioninfo

© Trivinci Systems, LLC Race-Keeper System User Guide v1.1.02, January 2011 Page 45 of 63



RACE-
KEEFPER

Using Compare to Improve Your Driving

One of the most effective methods to improve your driving is to compare yourself to against the best, whether it’s
someone else’s session or a particularly good session or lap or split of your own. Race-Keeper Comparo gives you
the power to easily compare laps and sessions on the same course.

How to Compare One Lap to Another Within the Same Session

To compare one lap to another within a session:

e Select Compare->Compare Laps

& Race-Keeper Comparo 0.11.02.38

File Compare Configure View Help
Open ‘ Compare Sync | Syncto Time ‘ Loop ‘
2 SCCA World Challenge + 2 SCCA World Challenge ==
= SESSION INFO O
2
Lap 2 ~03:01.91 1 11/10/2009 12:36:34.94 Lap4 00:00.46 2 11/10/2009 12:39:59.11 Course pr
Driver B Burgess B Burgess
Car 3
Date & Time 10/11/2009 12:33 PM 10/11/2009 12:33 PM 1
Type B
Laps 28 28
Best 6-01:3876 6-01:38.76
Currentlap 2-01:43.90 4-01:3899
lap1 03.01.91 03:01.91
lap2 01:43.90 01:43.90
- JECE 01:39.79 01:39.79
o o5 01:39.66 01:39.66
EMAP ol
Clickonmapto
change pasition
1000t
19 20l
¥ MPH (GPS 678 96.6
T LateralG 0.12
2|7 Inline @ 028 -008
I verical G -0.02 0.21
[ voitage 1395 14.00
"Il peltaTime  -B3.02s
Delta Dist  -3575.0m
- (¥ Distance " Time
2405ft 3608t 4811ft 6013ft 7216ft 8415ft 9621t 10824ft

A —Two laps from the same session, presented side-by-side (comparison of Lap 2 to Lap 4)

B — Data trace with primary session in green, comparison session in gray

C — Data pane for both laps

D — Track map for both laps

e E—Best lap and highlighted comparison lap
Compare mode automatically synchronizes sessions to each other; to re-sync at any point in a session, double-click
on the data graph or the course map.

For instructional video, please visit: www.race-keeper.com/comparo_screencasts?which=27 compareintro.

© Trivinci Systems, LLC Race-Keeper System User Guide v1.1.02, January 2011 Page 46 of 63



RACE-

KEEPER

How to Compare Laps in a Session to Laps in a Different Session

To compare one lap to another between different sessions:

e Select Compare->Compare Outings

e The Open menu pops up with sessions available for comparison (i.e., sessions from the same course)

& RaceKeeper Comparo 0.11.02.38

File Compare Configure View Help

< M b

Scan ¥ Show Preview

Delete Open

Throttle (OBD-11)
Coolant Temp (0BD-11)

MAP (0BD-11)
Fuel Level (0BD-11)

Lateral G
nline G

inininininininin)

73851ft 110776ft 147701ft 184627ft 221552t 258477ft 295402ft

Open \ Compare | \ Show 3D \ Loop |
E 5352_20100711_165921-37 o [P [
= SESSION INFO ol
11/7/2010 13:02:59.58 Course P
Driver
Car
Date & Time 7/11/2010 12:59 PM L
®° Open Outing - ==
o -
Search
Label | Start Time | Car | Course ‘ Driver | Type |
535220100711 165921-37 2010-07-11 12:59:21
VIRSunRace 2010-07-11 12:59:18 ACRX Keith Verges Race
o

Intake Air Temp (0BD-11]

Engine Load Calc [DBD-11)

Clicken mapte
change pasition

1000 ft
9o -

1221
122
89.00
43.00
065
050
015
0.01

o A —Name of the first session
e B — Names of the open session and another available session for comparison
e C—Video preview window of the second session

e Click on the session you want to compare

e Click on Open
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¢ When you click on Open, the two sessions, with video and data, are automatically displayed side-by-side

& RaceKeeper Comparo 0.11.02.38 =1 )

File Compare Configure View Help

open || Compare snc | SynctoTime|  show3n | Loop |

RPM (OBD-11) 9

¥ MPH (GPS 463
¢ rem (0BD-11) 2,891
. r

8% [~ Throtie [0BD-11) 173
[” Coolant Temp (0BD-11} 101.00

3265 ™ Intake Air Temp (0BD-11) 20,00
I~ MAP (0BD-11) 094

1632 [~ Fuel Level (08D-11) 0.23
I™ Engine Load Calc (0BD-1I) 0.22

[ Leteral G -103

41546t 62318t 83091t 1038647t 124637ft 145410f I inline G 0.43

E 5352_20100711_165921-37 + VIRSunRace o |[e [
= SESSION INFO 9 ol
Lap6 01:16.00 11/7/2010 13:16:40.47 lap4 01:13.34 11/7/2010 13:11:56.32 Driver Keith Verges - P
Car ACRX
Date & Time 7/11/201 7/11/201012:59 PM
Type Race
Laps 17 17 =
Best 6-02:02.18 12-01:57.05
Currentlap 6-02:02.18 4-01:57.91
lap1 07:38.82 58,63
lap2 02:09.02 2
lap3 02:06.22 571
ps 020855
Laps 02:03.18 01:57.68
o

Clickanmapta
change position

1000 ft
—

oo
3 :”.t?—j

156
105.00
40.00
122
063
0.16

o A —Two different sessions, side-by-side, on the same track

e B —Videos presented side-by-side

e C— Data traces for both sessions, overlaid on the same data graph

e D — Lap navigation slider bars for each session; faster laps display smaller intervals
e E — Data for each session, side-by-side

e F—Course map for both sessions, side-by-side

« G — Highlighted comparison laps (comparing lap 6 on the 1% session to lap 4 on the 2" session)

Compare mode automatically synchronizes sessions to each other; to re-sync at any point in a session, double-click

on the data graph or the course map.

For instructional video, please visit: www.race-keeper.com/comparo_screencasts?which=27 compareintro.
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How Expanded Video Window Changes in Compare Mode

When you use the Compare mode, Race-Keeper Comparo’s expanded video windows display large screen video
and animated gauge overlays.

¢ Videos are displayed side-by-side

& Race-Keeper Comparo 0.11.02.38

File Comparc Configure Yiew Help

open | [ Compare sync | synctoTime|  show3n |

5352_20100711_165921-37 + VIRSunRace

lap 6 01:16.00

11/7/2010 13:11:56.32

e A —Larger screen view of two different sessions, side-by-side, on the same track

e B —Lap stats, inter-lap navigation and intra-lap navigation slider bars
e C—Gauge sets for both sessions

Compare mode automatically synchronizes sessions to each other; to re-sync at any point in a session, double-click
on the data graph or the course map.

For instructional video, please visit: www.race-keeper.com/comparo_screencasts?which=28 comparescreen.
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How Expanded Data Graph Window Changes in Compare Mode

When you use the Compare mode, Race-Keeper Comparo’s expanded data graph window displays substantially
more data.

e Data traces are overlaid on the same data graph

& Race-Keeper Comparo 0.11.02.38
File Comparc Cenfigure View Help

open | G syne | syncto Time

5352_20100711_165921-37 + VIRSunRace

36935ft 55402ft 73870ft 92337t 1108054t 129272ft 147740t

T T
y j \ |
W
1 2 .
M MPH (GPS 41 1199
W RPM (0BD-II) pefs  59:2
W Throttle (0BD-11) 358 757
36935ft 55402ft 73870ft 92337t 110805ft |
I” Coolant Temp (QBD-11) 10100  106.00
I™ Intake Air Temp (OBD-11) 2000 4000
i maP (0BD-I 183 288|=
I” Fuel Level (0BD-11) 022 055
T Engine Load Cale (0BD-11) 053 084
[T lateral G -128 013
"1 Inline G 007 -058
[ vertical 6 015 014
[T voltage 1338 1370
I DeltaTime  -347s
Delta Dist 31485 m 1

36935ft 55402ft 73870ft 92337t 110805ft 129372 147740ft

toedittplit markers

e A —Data trace windows (user configurable)

B — Video thumbnails for each session

e C— Course map for reference

e D — Data sets for each session

e E—Lap navigation slider bars for each session

o F—Data markers for each session, with time/distance differences
Compare mode automatically synchronizes sessions to each other; to re-sync at any point in a session, double-click
on the data graph or the course map.

For instructional video, please visit: www.race-keeper.com/comparo_screencasts?which=28 comparescreen.

© Trivinci Systems, LLC Race-Keeper System User Guide v1.1.02, January 2011 Page 50 of 63



RACE-
KEEFPER

How Expanded Session Info Window Changes in Compare Mode

When you use the Compare mode, Race-Keeper Comparo’s expanded session info window displays substantially
more data.

e Split markers are displayed for both sessions, side-by-side

& Race-Keeper Comparo 0.11.0238
File Compare Configure View Help

open | showinfo | [ Show plits Compare s | syncto Time

m 5352_20100711_165921-37 + VIRSunRace

Target 2:00.52 156.18 9.41 908 1542 1488 2049 2015 2226 2092
1 7:3882 35863 33717 33497 000 1565 32906 2055 2369 2115 2009 1782 0.00 888 1555 888 24948
2 2:09.02 2:02.42 9.58 918 1635 1772 2226 2139 2482 2196 1949 1755 921 2.08 944 3.50
3 2.06.22 15751 9.64 1605 1512 2192 2025 2316 21.09 1932 1755 9.54 8.81 9.04 894 3.40
4 2.06.15 15791 911 1608 1505 2125 2092 2306 2042 9.24 9.01 B8l 3.37
5 2:03.18 1:57.68 951 918 1568 14895 2112 2035 2259 2122 1882 1762 891 8.81 878 8.81 3.37
6 2:02.18 1:57 68 9.41 908 1545 1515 2109 2029 2246 2102 1762 898 384 881 344
- 7 2:04.95 1:57.18 .44 911 1562 1498 2115 2025 2309 2092 1922 1762 9.28 8.88 9.01 874 3.40
Lap Lap time Max MPH 8 2:02.82 1:57.98 9.48 914 1582 1505 2079 2025 2239 2119 19.02 1765 9.14 8.88 8.98 8.88 3.37
6 020218 1491 El 2:04.45 1:58.48 9.48 918 1555 1552 2239 2045 2276 2119 1889 1765 9.08 8.88 9.08 871 3.40
10 2:03.22 1:57.85 958 911 1528 2092 2049 2272 2092 1969 17.62 9.21 8.81 881 874 334
1) 11 2:0375 1:5758 954 911 1648 1495 2085 2119 1905 1802 914 8498 898 868 3.50
12 2:08.42 2.61 908 1592 1518 2129 2025 2346 2092 2105 1752 a.64 8.88 944 858 3.57
13 20312 15761 10.21 911 1598 1515 2025 2272 2125 1895 1765 B.74 8.81 868 3.40
14 2:02.88 157.78 958 914 1545 2075 2069 2249 2092 1909 1798 9.21 874 908 871 3.40
15 2:03.62 1:57.85 9.48 911 1558 1505 2085 2042 2276 2135 1942 1758 9.41 8.81 9.04 861
' 16 3:0151 2:5837 1071 938 2239 1962 3166 2873 3694 3674 2853 2983 1185 1261 1318 1428 6.14
17 2:43.83 37.87 4094 0.00 214 033 2.87 0.00 0.00 0.00 0.00 0.00 0.00 0.00 000 38.54 1
q 0 b

e A —Lap times for each session

e B —Video thumbnails for each session

e C— Course map for reference

e D — Best splits for each session

e E—Lap navigation slider bars for each session

Compare mode automatically synchronizes sessions to each other; to re-sync the two vehicles at any point in a lap,
double-click on the data graph or the course map.

For instructional video, please visit: www.race-keeper.com/comparo_screencasts?which=28 comparescreen.

How to Re-sync Sessions in Compare Mode

Compare mode automatically synchronizes sessions to each other; as sessions 1 and 2 diverge because of different
driving performance and/or course conditions, the sessions will become out of sync.

To re-sync sessions in compare mode:
e Double-click anywhere on data graph
e Double-click anywhere on course map
e Click on the Sync button

e Select Compare->Sync Sessions

How to Un-compare Race-Keeper Sessions

To un-compare Race-Keeper sessions:

e Click on the Uncompare button and confirm action

© Trivinci Systems, LLC Race-Keeper System User Guide v1.1.02, January 2011 Page 51 of 63



[RAEE-H
KEEFPER

Using Export to Create Video Files with Data Overlays

Race-Keeper produces video and data files independently, which gives maximum flexibility to configuring gauge
overlays and exported video files. After your session, you can decide exactly how you want to configure data and

gauge overlays, and then change the overlays for different presentation requirements.
Race-Keeper Comparo offers two types of edit and export functions:
e Export a session to a video file (e.g., MPEG) for posting to the Internet

e Crop and save part of a session (e.g., best lap) for continued use with Race-Keeper Comparo

How to Export Race-Keeper Video with Gauges

To export video:

e Select File->Export Video...

Export Guide
1) Select configuration,
video quality, and
background
2) Use slider bar to
move to start of
export, then click
Start
3) User slide bar to
move to end of
export, then click
End [total export
time displayed
above Export button)
4) Select gauge and
data overlay (below)
5) To resize gauges
and videos, hold
Shift and click and
drag the gauge or
video window
6) Click Export
Gauge and
Data Overlay
Speedometer
Tachometer
Throttle
Accelerometer
- - W Course Map
— — DT o — — |7LapTimer

Lap Number

Configuration Video Quality Background 0:00 40:39 40:39

IExportZinsidel[picture-in-picturujIHigh-2354ME lea:e-Keeper j Startl End | Export | Cancel |

¢ Select video quality (configuration and background features are available with optional Dual Stream +

Export software plug-in, see www.race-keeper.com/dualstream+HDexport for more info)

e Grab and drag the Start indicator (green arrow) to beginning of planned export OR
e Play the video to the beginning of planned export and click on Start button
e Use the -> and <- keys to go forwards or backwards by one frame

e Grab and drag the End indicator (red arrow) to end of planned export OR
e Play the video to the end of planned export and click on End button

HD

¢ Note the estimated file size under Video Quality and the planned length of export in MM:SS above the Export

button
e Select gauge and data overlay for display, then grab and move gauges and data to preferred locations
e Resize gauges and data by holding Shift and grabbing the bottom right-hand corner of each widget
e Click Export, navigate to folder/file location, edit the file name, and click on Save

For instructional video, please visit: www.race-keeper.com/comparo_screencasts?which=31 export.
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Using Crop and Save As to Edit and Save Parts of a Session

Crop and Save As... gives you the power to edit and save selected part(s) of your track session and save all of the
session’s corresponding data for additional analysis or for distribution to your instructor, teammates or colleagues.

How to Crop and Save a Track Outing

To crop a session:
e Select File->Crop and Save As...

I Crop Cuting

1121 13719 1:58

5tart| End | Crop | Cancel |

e Grab and drag the Start indicator (green arrow) to beginning of planned copy OR
e Play the video to the beginning of planned copy and click on Start button
e Use the -> and <- keys to go forwards or backwards by one frame
e Grab and drag the End indicator (red arrow) to end of planned copy OR
e Play the video to the end of planned copy and click on End button
e Click Crop, navigate to folder/file location, edit the file name, and click on Save
For instructional video, please visit: www.race-keeper.com/comparo_screencasts?which=32 crop
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Software Add-On License Management

Race-Keeper system software and Race-Keeper Comparo are available at no charge to registered users at
www.race-keeper.com.

Race-Keeper also delivers optional Race-Keeper Comparo add-ons for special-purpose functionality:
e Race-Keeper iDash
e Race-Keeper Dual Stream + HE Export
e Race-Keeper ECU Data Modules
Each add-on requires a software license, which authorizes your Race-Keeper system to capture and transmit data
to Race-Keeper Comparo.
To Use Race-Keeper Comparo Software Add-ons:

¢ Purchase software add-on at www.race-keeper.com/store

Daal
Stream
Video

+

HD Export
18ROx1080

e Activate software license using Race-Keeper Comparo and your system serial number

e Copy software license file to your Race-Keeper system
For some of the Race-Keeper software add-ons (e.g., Dual Stream + HD Export), enhanced features will be available
within Race-Keeper Comparo.
Please refer to the Race-Keeper iDash User Guide for installation and operating instructions: www.race-
keeper.com/i-Dash.

Please refer to the Race-Keeper Dual Stream + HD Export User guide for system configuration and instructions:
www.race-keeper.com/dualstream+HDexport.

Please refer to the Race-Keeper ECU Data Module User Guides for system configuration and instructions:
www.race-keeper.com/dualstream+HDexport.
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Technical Specifications

Race-Keeper Video Data Systems

Video
e One system for video and data
¢ Video format - NTSC4 composite video camera inputs NTSC or PAL
¢ Video signal and power in single locking connector
¢ Simultaneous dual frame recording (two MPEG encoders record two camera views full frame)
e MPEG2 resolution (704x480 video resolution)
e Built-in export software to MPEG 4 and other popular video formats
e 30 FPS recording (NTSC)
e 2.5 Mbps - 8 Mbps video bit rate user configurable
e User defined video layouts using 1 to 4 cameras (full screen, picture-in-picture)
¢ Video out port for camera setup
Audio
e Two-channel input for stereo audio
e Single locking connector
e Built-in Automatic Gain Control for broad range of high and low sounds

e Line level or dynamic microphone inputs

Data and Data Sources

e User-positioned map, gauges and logo overlays

Ability to change overlays after video capture

High-res 4Hz GPS for speed, lap #, lap times and track map

Three axis on-board accelerometer (+6.0g range, 0.01g resolution) for Gs

Battery voltage, box temperature recorded
e OBD-Il data via USB 2.0
e WiFi ready

Race-Keeper SE
e Locking quick-release Hirose and RJ-45 connectors

¢ 8 multi-function analog sensor inputs (e.g., steering, throttle, brake)

8 multi-function digital sensor inputs (e.g., wheel speed, RPM)
OBD-II data via USB 2.0

e CAN-ECU data input

e 2 CAN I/O ports for ECU interface

Race-Keeper HE
e Locking quick-release Hirose waterproof connectors
¢ 3 multi-function analog sensor inputs (e.g., steering, throttle, brake)
¢ 2 multi-function digital sensor inputs (e.g., wheel speed, RPM)
e 1 CAN-ECU data input
e 2 CAN I/0O ports for ECU interface
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Recording Media and Estimate Recording Times

e Removable SD card

e Removable USB stick (Race-Keeper SE)

e Recording times dependent on size of SD card or USB stick and video resolution settings (examples below)

e Recording single stream at 2.5 Mbps for 1 hour requires approximately 1.1 GBs

e Recording single stream at 5.0 Mbps for 1 hour requires approximately 2.2 GBs

e Recording dual stream at 5.0 Mbps for 1 hour requires approximately 4.4 GBs

Membrane Panel Control Buttons

¢ Membrane switch panel with click and button feedback characteristics

e Power on/off

¢ Record/stop record

e Pause/unpause record (Race-Keeper SE)

Status LEDs

LED Color On Flashing Off
Status ) | Green=Ready to record Red/Green=System starting | Not ready to record
OR
Green with Red every 2
seconds =No GPS
Transfer () | Updating system, Accelerometer calibration Update complete
configuration updating, or stick/SD inserted
license file copying
Power ) | Red=Power connected, Red=Powering Power
system OFF Green=Low power disconnected
Green=Power on
Recording - Recording Stopping recording or Not recording

finishing boot up process

Memory LEDs

LED Color On Flashing Off
Memory I:' Yellow=Memory used >80% | Red=At 100% or no SD/USB <80% memory used
(Top)

Memory [:] Memory used=>25%, >50% NA No SD/USB or
(Bottom 3) and >75% memory used <25%
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Mechanical and Power

e Operating temperature: -20 to +55 C ambient
e Storage temperature: -20to +75C

Shock: 0.25m onto hard surface, except connector face
Vibration: 6g @ 0-1KHz random pattern

Compliant with FCC part 15 Class B, and current CE standards
12v DC, 1Amp (15W max)

e Locking power connector

Race-Keeper SE
e Custom flame retardant ABS enclosure
Width 7.35"/187mm
Depth 4.75"/121mm
Height (front) 1.4"/36mm
Height (back) 2.1"/53mm
Weight 1.1 1b/0.50kg

USB integrated into power loom for peripheral connection

Race-Keeper HE
¢ IP67 waterproof connectors, enclosure and membrane panel
Custom flame retardant ABS enclosure
Width 7.8"/198mm
Depth 5.5"/140 mm
Height (back) 2.0"/51mm
e Weight 1.3 Ib/0.59kg

Installation Options
e 3M dual lock Velcro (provided)

e 4-hole AMPS bolt pattern in case standard mount

¢ Integrated quick mounting plate
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Cameras

High-quality professional video cameras in enclosures designed for extreme motor sports environments.

e Available in two types of enclosures, see below
e Video format: NTSC

¢ Image sensor: 1/3" Sony ICX638 Super HAD CCD
e Scanning system: 2:1 interlace

e Total pixels: (H) 811 x (V) 508, 401K

¢ Electronic shutter: 1/60~1/100,000 (auto)

¢ S/N ratio: Over 45 dB AGC Off (high-res)

¢ Video output: 1 Vp-p, 75 Ohm

e Back light comp.: Yes

¢ Auto white balance: Yes

e Gamma correction: >0.45

¢ Sync mode: Internal synchronization

e Power source: DC12V * 10%

e Power consumption: 90mA maximum

e Operating temperature: -10°C ~ 45°C / 14°F~ 122°F
e Storing temperature: -20°C ~ 60°C / -4°F ~ 140°F
e Sensitivity: 0.2 lux/F=2.0 (high-res)

High-Res Mini Square

e Dimensions (mm): 30 (L) x 30 (W) x 11 (H), 28 (H) with lens
e Horizontal resolution: 550 TV lines (high-resolution)
e Mounting method: Integrated bracket secured with 3M VHB bonding tape

e Mounting location: Secure on any clean surface

High-Res Mini-Bullet

e Dimensions (mm): 66 (L) x 19 (W) x 19 (H)

Horizontal resolution: 550 TV lines (high-resolution)

Mounting method: L-bracket or collar clamp

Mounting location: Roll cage section or self-adhesive rubber bullet bracket
Water proof (IP 67)
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High-Res GPS

External GPS antenna has magnetic base for quick attachment to vehicle (can also be mounted using Velcro or 3M
VHB mounting tape). GPS antenna terminated with 15-foot cable for connection to Race-Keeper system.

4-Hz (four position measurements per second) electrically-shielded GPS engine embedded in Race-Keeper System.
GPS delivers high-resolution data used for vehicle speed, track mapping, lap number and timing, outing analysis
and syncing side-by-side outing comparisons.

e 4Hz sample rate

e GPS position accuracy: <2.5 m, horizontal

e 27dB active antenna

¢ Magnetic mount

e NMEA Input/output: ASCII, 0183, 2.3 (compatible to 3.0)

e Time to first fix: < 1 sec

e Acquisition and tracking sensitivity: -160dBm

e Max velocity measurement: 515 m/s (1000 knots)

e Dimensions: 50.5 mm Lx42 mm W x 13.9 mm H (1.99" x 1.65" x 0.55")

e Weight: 60 g (without cable)

e Power consumption: 30 mA (max)

e Environment: -40 to +85 C with high humidity
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Trouble-shooting

PC Requirements and Compatibility

What PC do | need to run Race-Keeper Comparo?

Race-Keeper Comparo video data analysis application will run well on most late-model PCs or laptops. Our
recommended PC specifications: Intel Dual Core 1.8GHz processor, 2GB RAM, 250GB hard drive, SD card reader.
Minimum specification: Celeron 1.6 GHz, 512Mram, with a 75Gig HD. PC may slow down when opening large
outings and when comparing two outings side by side.

What is the maximum SD card | can use?

We've used 32GB cards but the system has no limitation on storage media.

Is Race-Keeper Comparo compatible with Windows 7?

Yes.

Can | use Race-Keeper Comparo on a Macintosh?

Yes, Comparo will work on a Macintosh using either an emulator or on partitioned hard disk. We have had success
running Race-Keeper Comparo on Macs using a virtualization solution, like Parallels or VMware Fusion. Either of
these tools will allow you to run Windows "in a window" on your Mac. From there, you can install any normal
Windows applications, including our software. If you do install VMware or Parallels, be sure to enable 'Hardware
Accelerated 3D Graphics' in the settings for the virtual machine you create. Race-Keeper Comparo also runs
perfectly well under a partitioned hard drive on your Macintosh (e.g., Bootcamp).

We are working on a cross-platform version of Comparo that will work perfectly as a native Macintosh application;
we expect the software to be released in 2010.

Opening and Scanning Outings

Why can’t | see my outings in Race-Keeper Comparo?

If you can’t see your outings in Comparo...
e Ensure Race-Keeper Comparo is open before you attach an SD card or USB stick with Race-Keeper sessions.
When Comparo notes a new media device, the program will check for and repair any damaged files.

¢ If Race-Keeper sessions are on an SD card or USB stick, try running Windows CHKDSK on the attached media. If
SD card was removed from Race-Keeper while system was writing to the card, the ends of the video and data
files may need to be repaired; CHKDSK will perform this repair.

e Open session folders and remove any .tmp file extension from any files.

Why do my outings fail sometimes when | record to USB?

USB comms are not as reliable as SD; USB comms tend to me more susceptible to electrical noise and vibration. If
you’re in a high-vibration environment, we recommend recording directly to SD.

General Comparo Questions

Where can | find software release notes?

Please see www.race-keeper.com/comparo_release notes and www.race-keeper.com/capture release notes.

Why is Configure Race-Keeper menu partially displayed off-screen?

The window size can be adjusted by changing the DPI settings on your PC. In Windows 7, right click the desktop,
click personalize from the drop down menu, then click on Display, then select the standard {100%} default DPI, and
then click apply; changing DPI may require a computer restart for changes to take effect. After you restart your PC,
open Comparo and confirm that you are able to view the windows in their entirety.
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In Windows XP, right-click on the desktop and select Properties. In the pop-up window, select the Settings tab,
click Advanced button, select 96 in the DPI pull-down menu, then click OK; a restart may be required. After you
restart your PC, open Comparo and confirm that you are able to view the windows in their entirety.

Why does my session appear as only one lap in Race-Keeper Comparo?

If the start/finish line was moved by mistake to a place off the main track, then multiple laps could be merged onto
one long lap. Expand the Course Map window and drag the blue start/finish line to the correct place on the lap.

Does zero-ing the accel in Race-Keeper Comparo apply to one outing or to all?

When you zero the accelerometer in an outing, this offset will be applied to all outings so there is no need to re-
zero each time you load an outing.

Video Player

Why does my video look choppy?

Playing Race-Keeper outings on a PC or laptop that does not meet the minimum recommended specification can
cause the video to look very choppy when playing back in Comparo; the problem is exacerbated when comparing
two outings side by side.

Our recommended PC specification that will give a very good user experience is:
¢ Intel Dual Core 1.8GHz processor
e 2GB RAM
e 250GB HDD
e SD card reader
As for a minimum specification, use the following as a guide:
¢ Celeron 1.6 GHz
e 512MB RAM
e 75GB HDD
Note that while this minimum specification PC will run Race-Keeper Comparo well most of the time, it will slow
when opening large outings and when comparing two outings side by side.

Track Manager

How do | find the grid that shows each lap time and split?

Maximize the Session Info window, and then click on Show Splits at the top of the screen. Laps are displayed down
the left of the table. You can click on any of the split times and the video thumbnail will jump to that position on
that lap. You can play the video from that position by hitting the space bar, stop playback by hitting space bar
again. You can set up your splits by maximizing the Course Map and right-clicking anywhere on the map.

Is start/finish line saved with a track?

Once you have placed the start/finish line and split markers on a track, they are saved in Comparo for that track; all
further outings from that track will use the same start/finish and split markers. There is no need to load them into
the Race-Keeper box or re-enter them again.

How do | get rid of some of the tracks listed in Track Manager?

There presently is no way to delete a track...we've added this to the request list; a future release will address this
request.
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Cameras and Lenses

What’s a good way to protect my cameras?

High-res cameras deliver the best image quality when they’re clean and free of scratches or dust; over time, bullet
camera lens covers can degrade from use on the track. Clean the bullet camera lens cover, especially if mounted
on the outside of your vehicle, before and after every track session. We also recommend replacing camera lens
covers (available at www.race-keeper.com) after every track event to protect lenses and to prolong the life of the
lens glass.

Note: High-res mini-square cameras should never be used on the outside of a vehicle — they are not water proof
and do not have lens covers.

What are the lens covers in the replacement pack?

The 5-pack of replacement lens covers is for the Race-Keeper high res bullet camera. Lens covers are specially
coated with a scratch resistant film to help prevent damage from debris on the track. This will keep the camera
view clear for as long as possible while protecting your Race-Keeper camera lens. To ensure great clear video every
session, it is very important to inspect your bullet camera lens cover for damage and dirt before and after each
track outing. The lens cover is quick and easy to swap out by simply unscrewing the front of the bullet camera.

The windshield (front) view is washed out...can | adjust the white balance?

Race-Keeper cameras automatically adjust for different light levels.

We typically suggest using a separate camera for the interior view, and another for the exterior view. Follow this
link www.youtube.com/user/RaceKeeper#p/u/0/nXbWMxSZrvQ for an example of how separate cameras can be
used for the perfect interior and exterior views.

Where can | get some more sticky tape for camera mounts?

The double sided tape we supply for mounting the Race-Keeper standard mini square camera is manufactured by
3M. We tested many different adhesive tapes and found that the 3M™ VHB™ Tape 5952 was the best for
mounting on glass, painted metal, plastic, vinyl (including vehicle interior surfaces that had been polished). This
tape cures to form a very secure bond, yet when required it can be removed without leaving any residue. Available
from U-Line: www.uline.com/BL 6060/3M-5952-VHB-Acrylic-Foam-Tape.

Are special cameras required for high-def (HD) export?

No special cameras required for HD export. Best cameras, of course, are the high res cameras (550 TV lines). Dual
stream, of course, also is required. HD export feature allows you to place both streams on a 1920x1080 canvas,
add a graphical background.

Data and Data Sources

What is the sampling rate for analog sensors?

All of our data is sampled at 30Hz to match the 30FPS video frame rate. This means you see a new data sample for
every video frame as you step through the video one frame at a time (using right arrow and left arrow keys).

Where does the tach input cable connect?

The tach input cable feeds the tach signal (which you already use to drive a stand-alone tach display) into the Race-
Keeper system. The tach signal should already be conditioned to drive a tach display - that is, it should be a clean
square wave (0 - 5v or 0-12v) whose frequency varies with engine speed. Most Ignition systems and ECUs will have
a tach driver signal that can be used by Race-Keeper SE and Race-Keeper HE. For vehicles that don't have a tach
signal, we will soon be adding to the Race-Keeper Store an HT RPM sensor that can be connected to the HT lead of
a distributor; this sensors output can be connected into the tach input on Race-Keeper.
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Will OBD-Il interface work with motorcycles?

The OBD-II standard protocol is implemented by road car manufacturers to allow vehicle diagnostics. There isn't a
similar standard for bikes.

Where is Race-Keeper iDash on iTunes?

Open Apple iTunes, click on iTunes Store and type iDash in the search box at the top right-hand of the page. iDash
should be the only app that is displayed. Integrature is listed as the seller; we designed the app and Integrature
built the app and posted the app to iTunes.

How is the Race-Keeper iDash data transmitted from Race-Keeper system to the iPhone?
WiFi.

Can | use iDash and OBD-Il interface at the same time?

Yes. Speed and RPM data from the OBD-Il interface will be used on the iDash to drive the shift light and RPM
displays as well as the calculated gear position indicator. On the race-Keeper SE unit, there are three USB ports,
one on the side of the unit and one on the power cable. The third USB port is remote - it is on the Race-Keeper
Remote Control, this is an optional interface which be purchased from the Race-Keeper store. On the Race-Keeper
HE unit, there is one USB port on a 6-way locking connector on the connector panel - a Race-Keeper to USB cable is
supplied with iDash to use this port. The there is also the additional USB port on the Remote Control - this uses the
same connector as on the Race-Keeper SE.

Are there any iPhone or iPod Touch capacity requirements to work with Race-Keeper iDash?

The memory capacity of the iPhone or iPod Touch has no impact on the performance of the Race-Keeper iDash
app. All data displayed on the iDash is transmitted live from the Race-Keeper system, and all calculations are
performed live.

Installation

Are connectors for Race-Keeper SE interchangeable with Race-Keeper HE?

The cameras, GPS and mic are interchangeable and can be used with either the HE or SE video data systems; the
power loom is not interchangeable between SE and HE.

What is the slot in the front of Race-Keeper HE?

Race-Keeper can be powered using a 12v battery, making the system very portable and allowing its use where a
12v vehicle supply is not easily available. Race-Keeper HE has a battery strap slot in the front of the enclosure,
which allows a rechargeable battery to be secured to the enclosure using a Velcro strap that wraps around the
battery and through the enclosure slot. This makes it very quick and easy to swap out a used battery for a fully
charged battery.
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